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Outlook : ระบบอีเมลและปฏิทินนัดหมายท่ีใช้งานแพร่หลายท่ีสดุของโลก 

อเีมลคอื เครื่องมอืการตดิต่อสื่อสารอย่างเป็นทางการของธุรกจิ ดงันัน้ การเขา้ใชง้านอเีมลจงึควรท าไดจ้ากทุกทีบ่นทุก
อุปกรณ์ เพื่อตอบโจทยธ์ุรกจิทีต่้องการความคล่องตวัสูง Microsoft 365 มบีรกิาร Outlook ซึ่งเป็นบรกิารที่ใชง้านทัว่
โลก ช่วยใหส้ามารถใชง้านอเีมล ปฏทินิ และรายชื่อผูต้ดิต่อได้ ไม่ว่าผู้ใชจ้ะสะดวกใช้งานบนอุปกรณ์ใดกต็าม ทัง้ยงั
สามารถใชง้านกบัโปรแกรม Office ทีทุ่กคนคุน้เคยไดเ้ป็นอย่างดอีกีดว้ย ในบทนี้เราจะพดูถงึเรื่องดงัต่อไปนี้ 

• การจดัระเบยีบอเีมล โดยมุ่งเน้นไปทีป่ระสทิธภิาพสงูสดุ 

• จดัการปฏทินิของคุณ เพื่อก าหนดตารางการประชุมและนดัหมาย 

• หมดกงัวลเรื่องขนาดของไฟล ์โดยการแชรไ์ฟลจ์ากคลาวด ์เพื่อให้มเีวอรช์นัล่าสดุเสมอ 

• การเชื่อมต่อผ่าน Microsoft Outlook Application 

บทบาทสมมต ิ 

 

 
 
คุณ Veronica, พนกังานฝ่ายขาย 

 

เลา่เรือ่ง 

คุณ Veronica เป็นพนักงานฝ่ายขายคนใหม่ ซึง่ทีบ่รษิทัมกีารใชง้าน Outlook ในการตดิต่อธุรกจิกบัลูกคา้ ในหนึ่ง
วนัมอีเีมลจ านวนมาก และตอ้งท าปฏทินินดัหมายลกูคา้ คุณ Veronica จ าเป็นตอ้งเรยีนรูอ้ย่างรวดเรว็ในการใชง้าน 
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Mail 

1. ท าความรูจ้กั Microsoft Outlook 

ลกัษณะหน้าตาเริม่ตน้ของ Microsoft Outlook on PC 

 

ลกัษณะหน้าตาเริม่ตน้ของ Microsoft Outlook Online 

 

ส่วนท่ี 1 : New Mail ปุ่ มส าหรบัการสรา้งอเีมลใหม่ทนัท ี
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ส่วนท่ี 2 : Inbox กล่องจดหมายทัง้หมด ทัง้อเีมลทีไ่ดร้บั อเีมลทีส่ง่ออกไป หรอือเีมลทีล่บไปแลว้ รวมไปถงึบนั
ทกีการสนทนาทีเ่กบ็อยู่ในโฟลเดอร ์Conversation History และหากมกีารท า Archive (เกบ็อเีมลถาวร) กจ็ะเขา้ไปอยู่
ในสว่นของ In-Place Archive  

ส่วนท่ี 3 : Mail List แสดงรายการอีเมลทัง้หมด ถ้าเป็นอีเมลที่ยังไม่ได้อ่าน รายการนัน้จะเป็นสีเข้มขึ้น 
นอกจากนี้ยงัสามารถค้นหาอเีมลได้ตามเงื่อนไขต่างๆ เช่น ตามเวลา ตามหวัขอ้เมล เป็นต้น รวมถึงมกีารแบ่งแยก
หมวดหมู่ชดัเจน เป็น All (ทัง้หมด), Unread (ยงัไม่ไดอ้่าน), To Me (ถงึฉนั) และ Flagged (ตัง้ค่าสถานะ) 

ส่วนท่ี 4 : Setting Bar แถบทางลดัในการเขา้ถงึฟีเจอรต่์างๆ การตัง้ค่า จบอยู่ภายในฟันเฟืองเดยีว  

ส่วนท่ี 5 : Reading View ส่วนแสดงผลอเีมลแต่ละเมล แต่ใหส้งัเกตว่า ถ้าเมลมหีวัขอ้เดยีวกนัจะแสดงผลเป็น
เมลย่อยๆ เพื่อช่วยใหผู้ใ้ชง้านไม่ต้องเปิดเมลหลายๆ เมล พรอ้มทัง้สามารถส่งอเีมลโต้ตอบไดท้นัทใีนหน้าต่างเดมิอกี
ดว้ย 

2. เชค็และจดัการอีเมลได้อย่างง่ายดาย 

การสรา้งอีเมล 

คลกิที ่New Mail หรอืใชแ้ป้นพมิพล์ดั Ctrl+N เพื่อใหแ้สดงผลหน้าอเีมลใหม่ขึน้มา ใหพ้มิพช์ื่อผูร้บัทีต่อ้งการสง่อเีมลไป
ใหล้งในช่อง To: ถา้ผูใ้ชง้านตอ้งการเพิม่ผูร้บั  

ผูใ้ชง้านสามารถพมิพช์ื่อเพิม่เตมิลงไปทีช่่อง To: ได ้หรอืจะพมิพล์งในช่อง CC: กไ็ดห้ากตอ้งการใหผู้ร้บันัน้เพยีงรบัรู้
เน้ือหาในอเีมลเท่านัน้  

ข้อสงัเกต: หากชื่อที่พมิพ์ลงไปเป็นผู้รบัอเีมลทีผู่้ใช้เคยส่งเมลไปใหแ้ล้ว Outlook จะจ าได้และขึน้ชื่อมาใหเ้ลอืกโดย
อตัโนมตั ิดงัภาพ  

Microsoft Outlook 

 

Outlook Online 

ปรากฏช่ือท่ีเคยพิมพก่์อนหน้าน้ี 
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อกีหนึ่งฟีเจอรส์ าหรบัการส่งเมล คอื ช่อง BCC: มไีวใ้หผู้ใ้ชเ้พิม่ผูร้บัทีไ่ม่ต้องการใหผู้ร้บัอื่นๆ ทราบว่าผูใ้ชส้่งอเีมลหา
บุคคลนัน้ดว้ย เมื่อตอ้งการใหห้น้าต่างอเีมลใหม่ มปีุ่ ม BCC: ปรากฏขึน้ สามารถท าไดส้องวธิคีอื 

Microsoft Outlook 

1. คลกิทีปุ่่ ม CC: จะปรากฏหน้าต่าง Select Names: Global Address List  ซึง่จะมปีุ่ ม BCC-> อยู่ดา้น
ล่างสดุ ดงัภาพ 

 

 

ปรากฏช่ือท่ีเคยพิมพก่์อนหน้าน้ี 
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2. ที่เมนูหลกั ให้ไปที่แทบ็ Options คลกิปุ่ ม BCC เพื่อให้ปุ่ ม BCC… วางต่อท้ายปุ่ ม CC… ในหน้าต่าง
อเีมลใหม่เสมอ ดงัภาพ 

 

Outlook Online 

คลกิทีปุ่่ ม Bcc 

 

3. การตอบกลบั (Reply/Reply all) และส่งต่อ (Forward)  
เมื่อใดที่ผู้ใชต้้องการตอบกลบัหรอืส่งต่ออเีมล ผู้ใช้งานสามารถท าได้ทนัทดีว้ยการคลกิปุ่ ม Reply หากต้องการตอบ
กลบัเฉพาะผู้ส่งเท่านัน้ คลิกปุ่ ม Reply all หากต้องการตอบกลบัทุกคนที่มรีายชื่ออยู่ในอีเมลที่ได้รบั หรือคลิกปุ่ ม 
Forward หากตอ้งการสง่ต่ออเีมลนัน้ไปยงับุคคลอื่นๆ  

  

Option > BCC 
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Microsoft Outlook 

 

Outlook Online 

 

4. การตัง้ค่ารปูแบบเร่ิมต้นของอีเมล 

เมื่อตอ้งการตัง้ค่าใหร้ปูแบบอเีมลมคีวามเป็นมาตรฐานในทุกๆ อเีมลทีส่ง่ออกไป สามารถท าไดด้ว้ยวธิกีารดงัต่อไปนี้ 
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Microsoft Outlook 

คลกิ File > Options > Mail > Message Format 

 

Outlook Online 

คลกิเครื่องหมาย เลอืก View all Outlook Settings 

 

 

 

 

 

 

 

 

 

File > Options > Mail > Message Format 
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ไปที ่Mail > Compose and reply > Message Format ผูใ้ชง้านสามารถเลอืกฟอนต์ทีผู่ใ้ช้งานต้องการ หรอืจะเลอืก
ใหห้น้าต่างการเขยีนอเีมลแสดง BCC ทุกครัง้กส็ามารถท าได ้

Settings > View all Outlook Settings 
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5. การค้นหาอีเมลอย่างรวดเรว็ 

เมื่ออเีมลเริม่มจี านวนมากขึน้ การคน้หาอเีมลเก่านัน้อาจต้องใชเ้วลานาน Outlook จงึไดม้เีครื่องมอืพรอ้มใชเ้พื่อใหก้าร
คน้หามคีวามสะดวกมากยิง่ขึน้ ผูใ้ช้งานสามารถจดัเรยีงผลลพัธก์ารคน้หาตามวนั ไฟลแ์นบ หรอืความส าคญัได ้อกีทัง้
เมนู Focused Inbox ยงัช่วยแยกอเีมลทีส่ าคญั และไม่ส าคญัออกโยจะแสดงบนแทบ็ Other  

Microsoft Outlook  

คลกิขวาที ่Newest เลอืก Show Focused Inbox 

Mail > Compose and 
reply > Message Format 
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Outlook Online 

คลกิ เลอืก Focused Inbox และท าการเปิดฟีเจอรน์ี้ 

 

Newest > Show Focused Inbox 

Settings > Show Focused Inbox 
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6. ใช้ @ ในการอ้างอิงถึงบุคคลในอีเมล 

ในการเขยีนอเีมล หากมกีารกล่าวถงึบุคคล เมื่อก่อนเราตอ้งนัง่อ่านจนหมดว่าหมายถงึเราหรอืไม่ ตอนนี้ง่ายแลว้ เพยีง
แค่ใชเ้ครื่อง @ และตามดว้ยชื่อ จะแสดงไฮไลทช์ื่อของเรามาทนัท ี

Microsoft Outlook 

พมิพ ์@ จะปรากฏรายชื่อ 

 

ผูร้บัสามารถ Filter หากมกีารอา้งถงึ Mentioned Mail ไดเ้ลยทนัทใีน Inbox 

 

Outlook Online 

พมิพ ์@ จะปรากฏรายชื่อ 

พิมพ ์@ เพื่อระบบุุคคลท่ีอ้างถึงในอีเมล 
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ผูร้บัสามารถ Filter หากมกีารอา้งถงึ Mentioned Mail ไดเ้ลยทนัทใีน Inbox 

 

7. แนบลิงค ์แทนการแนบไฟล ์

การสง่ไฟลแ์นบนัน้ท าไดง้่ายขึน้และท าไดห้ลายไฟลพ์รอ้มๆ กนั โดยมขีัน้ตอนดงันี้ 

Microsoft Outlook 

คลิก Insert > Attach Files แล้วกดปุ่ ม Browse เลือก Browse Web Locations หากต้องการค้นหาไฟล์จากใน 
OneDrive for Business หรือไฟล์จากกลุ่มใน Microsoft Teams / SharePoint Online  หรือใช้วธิแีบบเดิมคอืเลอืก
จากภายในคอมพวิเตอร ์โดยเลอืก Browser This PC…  

พิมพ ์@ เพื่อระบบุุคคลท่ีอ้างถึงในอีเมล 
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Outlook Online  

คลกิ Attach เลอืก Browse Cloud locations 

 

เลอืกไฟลท์ีต่อ้งการ โดยแบ่งจากแหล่งทีม่าเป็น 3 ประเภทคอื 

• Computer: แนบไฟลจ์ากเครื่องคอมพวิเตอรข์องตนเอง 

• OneDrive for Business: แนบไฟลจ์ากใน OneDrive for Business ของตนเองหรอืไฟลท์ีม่คีนเคยแชรไ์วใ้หเ้รา 

• Recent Attachment: ไฟลท์ีม่กีารแนบล่าสดุ 

 

 

 

 

 

 

Insert > Attach Files > Browse Web Locations 
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8. การเพ่ิมลายเซน็ต่อท้ายอีเมล 
ในการสง่อเีมลแบบเป็นทางการ สิง่ทีข่าดไม่ไดค้อืลายเซน็ลงทา้ยอเีมล เพื่อบ่งบอกว่าผูใ้ชง้านมาจากหน่วยงานใด โดย
วธิกีารสรา้งลายเซน็และแนบไปกบัเมลของผูใ้ชง้านมดีงัต่อไปนี้ 

Microsoft Outlook 

คลกิ File > Options > Mail > Signatures 

 

File > Options > Mail > Signatures 
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Outlook Online 

ใหค้ลกิเครื่องหมาย  แลว้เลอืก View all Outlook Settings 

 

Settings > View all Outlook Settings  
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ไปที ่Mail > Compose and Reply > Email Signature ถ้าต้องการใหล้ายเซน็ปรากฏขึน้ในอเีมลทีส่่งออกทุกครัง้ ให้
เลอืก Automatically include my signature on messages I send ลายเซน็จะปรากฏทุกครัง้เมื่อมกีารสร้างอเีมล
ใหม ่

 

9. การแนบอีเมลอีกฉบบัลงในอีเมลท่ีต้องการส่งออก 

ในบางกรณีทีผู่ใ้ชง้านตอ้งการแนบอเีมลฉบบัอื่นไปกบัอเีมลของผูใ้ชง้านเอง เพื่ออา้งองิขอ้มูลดา้นใน แต่ไม่ต้องการสง่
ต่อ ผูใ้ชง้านสามารถแนบอเีมลนัน้ไปกบัอเีมลของตนเองได ้โดยใชว้ธิเีปิดหน้าต่างการสรา้งอเีมลใหม่ขึน้มา จากนัน้ใน
หน้าต่างแสดงรายการอเีมลทัง้หมด ใหค้ลกิทีอ่เีมลทีต่อ้งการ แลว้ Drag & Drop (ลากแลว้วาง) อเีมลทีต่้องการไปวาง
ในอเีมลใหม่ทีก่ าลงัสรา้ง เมื่อใสข่อ้ความทีต่อ้งการลงในอเีมลแลว้ ใหค้ลกิ Send เพื่อสง่อเีมลออกไป 

 

 

 

 

 

 

Mail > Compose and Reply > 

Email Signature 
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Microsoft Outlook 

 

Outlook Online 

 

10. การย้ายอีเมลไปยงัโฟลเดอรท่ี์ต้องการ 

ในกรณีทีผู่ใ้ชง้านตอ้งการจดัระเบยีบกล่องจดหมายของตนเอง ผูใ้ชง้านสามารถสรา้งโฟลเดอร์ ต่างหาก แลว้ยา้ยอเีมล
ต่างๆ จดัเขา้โฟลเดอรท์ีเ่กีย่วขอ้ง เพื่อความเป็นระเบยีบเรยีบรอ้ยและสะดวกในการคน้หา  

Microsoft Outlook 

คลกิขวาเลอืก Move ไปยงัโฟลเดอรท์ีต่อ้งการ 

 

 

 

 

แนบอีเมลโดยการลากอีเมล และ
วางในอีเมลฉบบัใหม ่

แนบอีเมลโดยการลากอีเมล และ

วางในอีเมลฉบบัใหม ่
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หากต้องการสร้างโฟลเดอร์ใหม่ ให้คลกิขวาที่ชื่อบญัชขีองตนเอง แล้วเลอืก New Folder… แล้วตัง้ชื่อโฟลเดอรต์าม
ตอ้งการ  

 

Outlook Online 

คลกิขวาเลอืก Move แลว้เลอืกโฟลเดอรท์ีต่อ้งการยา้ยอเีมลไป 
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11. การลบอีเมล 

ในการลบอเีมลทีไ่ม่ตอ้งการ ใหค้ลกิที ่  บน Microsoft Outlook หรอื  บน Outlook Online ทีอ่ยู่ต่อจากอเีมลฉบบั
นัน้ แลว้อเีมลนัน้จะถูกยา้ยไปทีโ่ฟลเดอร ์Deleted Items เมื่อครบก าหนด 30 วนั อเีมลนัน้จะถูกลบออกจากระบบ 

Microsoft Outlook 

 

ถา้ตอ้งการลบอเีมลทัง้หมดในโฟลเดอร ์Deleted Items ใหค้ลกิขวา แลว้เลอืก Empty folder 

 

Outlook Online 
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แต่หากตอ้งการกูค้นือเีมลทีล่บไป ใหค้ลกิ Recover deleted items (ภายใน 30 วนัเท่านัน้) 

12. การตัง้ค่าการตอบกลบัอตัโนมติัเมื่อไม่อยูใ่นออฟฟิศ (Out-of-Office Auto Reply) 
การตัง้ค่าการตอบกลบัอตัโนมตัจิะช่วยใหผู้อ้ื่นทราบไดว้่า ผูใ้ชง้านไม่อยู่ในออฟฟิศและไม่สามารถตอบกลบัอเีมลไดใ้น
ขณะนัน้ๆ  

Microsoft Outlook 

คลกิที ่File > Automatic Replies 

 

เลอืกการตัง้ค่าว่าตอ้งการตอบกลบัในช่วงเวลาใดดว้ยการกาเครื่องหมายทีก่ล่อง Only send during this time range: 
แลว้คลกิเลอืกเวลาทีต่้องการ จากนัน้ ใส่ขอ้ความทีต่้องการแจง้แก่ผูส้่งว่า จะไม่อยู่และจะกลบัมาอกีเมื่อใด โดยใหใ้ส่
ขอ้ความทัง้ในแทบ็ Inside My Organization และ Outside My Organization (On)  

 

 

File > Automatic Replies 
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Outlook Online 

 

ส าหรบัวธิกีารตัง้ค่า ใหไ้ปที ่Layout > Automatic Replies  

 

การตัง้ค่าการตอบกลบัเฉพาะคนในองคก์ร เราสามารถบลอ็กในปฏทินิของเราไดท้นัทโีดยเลอืก Block my calendar 

for this period หรือหากมีคนส่ง invite มาหาเราให้ตอบกลบัอตัโนมตัิพร้อมกบั Decline ให้เลือก Automatically 
decline new invitations… และถา้ตอ้งการใสข่อ้ความตอบกลบัใหเ้ลอืก Decline and cancel my meetings… 

Layout > Automatic Replies 
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การตัง้ค่าการตอบกลบัเฉพาะคนนอกองคก์ร หรอืเฉพาะในรายชื่อผูต้ดิต่อจองเรากส็ามารถท าไดเ้ช่นกนั 

 

 

13. MailTip ตวัช่วยเตือนอีเมลก่อนท่ีจะส่งผิด 

บางครัง้ ชื่อของบุคคลต่างๆ อาจซ ้ากนัหรอืคลา้ยกนั ดงันัน้ การสง่อเีมลจงึตอ้งระมดัระวงัในสว่นของชือ่ผูร้บัดว้ย ดงันัน้ 
ฟีเจอร ์MailTip จงึเขา้มาช่วยเป็นตวัเตอืนแบบอตัโนมตั ิคอยแจง้เตอืนก่อนทีจ่ะสง่เมลออกไป 

 

 

ลอ็คตารางวลาในปฏิทินของตนเอง 

ปฏิเสธโดยอตัโนมติั เมือ่มีการ Invite ใหม่ 
ระหว่างช่วงเวลานัน้ 

ใส่ขอ้ความตอบกลบั 

ในการปฏิเสธ 
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Microsoft Outlook 

 

Outlook Online 

 

14. การป้องกนัอีเมลไมใ่ห้ส่งไปยงัโฟลเดอร ์Junk Email และบลอ็กอีเมลท่ีไม่ต้องการ 

ต า ม ป ก ติ ร ะ บ บ  Outlook จ ะ มี ก า ร ต ร ว จ จั บ ว่ า รู ป แ บ บ อี เ ม ล ที่ ส่ ง ม า นั ้ น เ ป็ น 
สแปมเมลหรอืไม่ แต่บางครัง้อเีมลเหล่านัน้กไ็ม่ใช่สแปมเสยีทัง้หมด ดงันัน้ การตัง้ค่าเพื่อใหร้ะบบเรยีนรูแ้ละไม่ให้ส่ง
อเีมลเหล่านัน้ไปยงัโฟลเดอร ์Junk Email จงึมปีระโยชน์ โดยมวีธิกีารดงัต่อไปนี้ 

Microsoft Outlook 

ใหค้ลกิขวาทีอ่เีมลทีต่อ้งการ แลว้เลอืก Junk > Junk E-mail Options 

 

เลอืก Safe Sender กรอกโดเมน แลว้คลกิ OK 

แจ้งเตือนอีเมลนอกองคก์ร 

แจ้งเตือนอีเมลนอกองคก์ร 

Junk > Junk E-mail Options 
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ถา้ตอ้งการบลอ็กผูร้บั ใหไ้ปที ่Blocked Sender 

 

Outlook Online 

 ให้คลิก View all Outlook Settings > Junk email > Safe Senders and domains จากนั ้น กรอกอีเมลที่ผู้ ใช้

ตอ้งการ แลว้คลกิ   
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ส าหรบัอเีมลทีต่้องการบลอ็ก ให้เลื่อนลงไปที ่Blocked senders and domains แล้วกรอกอเีมลหรอืโดเมนแลว้คลกิ 

 

 

15. สรา้งกฎให้กล่องจดหมาย 

ผู้ใช้งานสามารถสร้างกฏในการรับส่งอีเมลได้ โดยสามารถสร้างครัง้เดียว อาจจจะใน Microsoft Outlook หรือ 
Outlook Online แลว้ใชร้่วมกนัไดท้ัง้บน Microsoft Outlook และ Outlook Online  

Microsoft Outlook 

คลกิขวาทีอ่เีมลทีต่อ้งการ ใหเ้ลอืก Rules > Create Rules แลว้สรา้งกฎตามตอ้งการ 

อนุญาตรายบุคคลและโดเมน 

บลอ็ครายบุคคลและโดเมน 
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ก าหนดเงื่อนไขของกฎ แลว้ก าหนดการแจง้เตอืน 

 

Outlook Online 

 คลกิขวาทีอ่เีมลทีต่อ้งการ ใหเ้ลอืก Rules > Create Rules แลว้สรา้งกฎตามตอ้งการ 

 

ตัง้ชื่อกฎและก าหนดเงื่อนไขตามตอ้งการ 

Rules > Create Rules 

Rules > Create Rules 
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Calendar 

16. ไม่พลาดทุกการนัดหมายด้วยการใช้ปฏิทิน (Calendar) 
ในการท างานร่วมกนัเป็นทมีอย่างเป็นระบบ หลายๆ ครัง้จ าเป็นต้องมกีรอบเวลาและก าหนดการทีช่ดัเจน เพื่อใหง้าน
ด าเนินไปอย่างราบรื่นทีส่ดุ Outlook ไดเ้ตรยีมฟีเจอร ์Calendar เพื่อมาตอบโจทยน์ี้โดยเฉพาะ ท าใหท้ราบไดท้นัทวี่า มี

ใครว่างเขา้ประชุมไดบ้า้ง ตลอดไปจนถงึการมอบหมายงานใหเ้สรจ็ตามเวลาทีต่ัง้ไวไ้ด ้โดยเลอืกทีเ่มนู  บน 

Microsoft Outlook หรอื  ใน Outlook Online 

ลกัษณะหน้าตาเร่ิมต้นของปฏิทินใน Microsoft Outlook 

สามารถสลบัการใชง้านระหว่างจดหมาย ปฏทินิ บุคคล และอื่นๆ ได ้
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ลกัษณะหน้าตาของปฏทินิบน Outlook Online  

 

ส่วนท่ี 1 : ผูใ้ชง้านสามารถเพิม่การนดัหมายไดด้ว้ยการคลกิปุ่ ม New  

ส่วนท่ี 2 : แสดงปฏทินิแบบย่อ ผูใ้ชง้านสามารถคลกิดรูายละเอยีดในแต่ละวนัได้ 

ส่วนท่ี 3 : แสดงประเภทของปฏทินิ โดยผูใ้ชง้านสามารถเพิม่จ านวนปฏทินิไดม้ากเท่าทีต่อ้งการ 

ส่วนท่ี 4 : แสดงหวัขอ้ของงานในแต่ละวนั 

ส่วนท่ี 5 : แสดงมุมมองของปฏทินิ  
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ส่วนท่ี 6 : แสดงเมนูการแชรป์ฏทินิใหผู้อ้ื่น และแสดงการพมิพป์ฏทินิผ่านทางเครื่องพมิพ์ได ้

17. วิธีการสรา้ง แก้ไข ลบนัดหมาย 

ผูใ้ชง้านสามารถเพิม่นดัหมายง่ายๆ ได ้

Microsoft Outlook 

คลกิ New Meeting 

 

Outlook Online 

คลกิ New Event 

 

เพิม่รายละเอยีดของการนดัหมาย ตัง้แต่หวัขอ้ สถานที ่ผูเ้ขา้ร่วมการประชุม วนัที ่เวลา รวมถงึรายละเอยีดต่างๆ 

Microsoft Outlook 
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Outlook Online 

 

ถา้ผูใ้ชง้านตอ้งการด าเนินการประชุมในแบบออนไลน์ สามารถท าไดผ้่าน Teams Meeting ดงันี้ 

Microsoft Outlook 

คลกิ Skype Meeting 

 

ระบบจะแปลงการนดัประชุมใหเ้ป็น URL เพื่อใชเ้ป็นเซสชนัการประชุมเฉพาะของผูใ้ชง้าน โดยใครกต็ามทีไ่ดร้บัลงิกน์ี้ก็
จะสามารถเขา้ร่วมประชุมดว้ยได ้
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Outlook Online 

เลอืก Teams meeting 

 

เมื่อกรอกขอ้มลูครบตามตอ้งการแลว้ ใหค้ลกิ Send 

 

จะปรากฏลงิคส์ าหรบัการประชุมออนไลน์ 
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ถ้าต้องการแกไ้ขนัดหมาย ใหไ้ปทีก่ารนัดหมายนัน้ๆ แลว้คลกิปุ่ ม Edit เมื่อแกไ้ขเสรจ็แลว้ ใหค้ลกิ Send เพื่อส่งการ
แกไ้ขนัน้ไปถงึทุกคน 

เมื่อตอ้งการเขา้ร่วมประชุม ใหค้ลกิ Join แต่ถา้ตอ้งการยกเลกิการนดัหมายนี้ ใหค้ลกิ Cancel 

18. การตอบรบันัดหมายในอีเมล 
หลงัจากทีส่่งอเีมลการนัดหมายออกไปแล้ว ผู้รบัสามารถตอบกลบัหรอืส่งต่อให้กบับุคคลอื่นทีเ่กีย่วขอ้งได ้ในกรณีที่
ผูร้บัต้องการยนืยนัการเขา้ร่วมประชุม ใหค้ลกิ Accept ถ้าไม่แน่ใจ ใหค้ลกิ Tentative และถ้าไม่ต้องการเขา้ร่วม ให้
คลกิ Decline หรอืหากตอ้งการเสนอเวลาทีต่อ้งการใหม่ ใหเ้ลอืก Propose new time 

 

ในการตอบกลบัการนดัหมาย ผูร้บัจะมตีวัเลอืกในการตอบกลบัคอื 

เลือกประเภทของการตอบกลบั 
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- Edit the response before sending: เพิม่ขอ้ความแนบไปกบัการตอบกลบั 

- Send the response now: ตอบกลบัทนัท ีโดยไม่มกีารเพิม่ขอ้ความใดๆ 

- Don’t send the response: ตอบกลบัทนัท ีแต่ไม่ตอ้งสง่อเีมลถงึผูน้ดัหมาย 

เมื่อผูร้บักดตอบรบัแลว้ เช่น Accept ผูส้ง่จะเหน็ว่าสถานะล่าสดุว่ามใีครเขา้ประชุมบา้ง 

 

และเมื่อคลกิทีล่งิก ์จะเหน็ทนัทวี่ามใีครตอบกลบับา้ง 

 

แสดงจ านวนของการตอบรบัการประชมุ 
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19. การนัดหมายการประชุมท่ีเกิดขึน้เป็นประจ า 

ในกรณีทีก่ารประชุมนัน้เกดิขึน้เป็นประจ า เช่น การประชุมทมีทุกๆ สองสปัดาห ์หรอืการประชุมผูบ้รหิารประจ าปี เป็น
ตน้ ผูใ้ชไ้ม่จ าเป็นตอ้งสรา้งการนดัหมายการประชุมทลีะครัง้ แต่สามารถสรา้งครัง้เดียว แลว้ก าหนดใหก้ารนดัหมายการ
ประชุมนี้เกดิขึน้ตามช่วงเวลาทีต่้องการได ้โดยในหน้าการนัดหมายการประชุม ใหเ้ลอืก Repeat แลว้เลอืกเวลาทีผู่ใ้ช้
ตอ้งการใหเ้กดิขึน้เป็นประจ า เช่น ทุกวนั ทุกๆ วนัพุธ ทุกวนัท างาน เป็นตน้ 

Microsoft Outlook 

คลกิ Recurrence ตามภาพ 

 

เลอืกเวลาทีต่อ้งการใหก้ารประชุมเกดิขึน้เป็นประจ า 

 

Outlook Online 

หลงัจากที่คลกิสร้างการนัดหมายใหม่แล้ว ในส่วน Repeat ให้เลอืกช่วงเวลาที่ต้องการให้การนัดหมายนี้เกดิขึน้เป็น
ประจ า ดงัภาพ  

เลือกเวลาท่ีต้องการให้เกิดขึน้เป็นประจ า 
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20. การเลือกมมุมองการดปูฏิทินหรอื Calendar View 

ผูใ้ชง้านสามารถเลอืกมุมมองการดูปฏทินิตามทีต่นเองชื่นชอบได ้เช่น ต้องการดูแบบเป็นเดอืน เป็นสปัดาห ์ดูเฉพาะ
วนัท างานในสปัดาห ์เป็นตน้  

Microsoft Outlook 

 

Outlook Online 

 

21. การเพ่ิมปฏิทินจาก Calendar อ่ืน 

นอกจากปฏทินิทีใ่ชส้ าหรบัการท างานแลว้ ผูใ้ชง้านสามารถสรา้งปฏทินิอื่นๆ ไดอ้กี เช่น ปฏทินิส่วนตวัหรอืครอบครวั 
ปฏทินิของเพื่อนร่วมงาน เป็นตน้  

วิธีการเพ่ิมปฏิทินของเพื่อนรว่มงาน 

เลือกเวลาท่ีต้องการให้เกิดขึน้เป็นประจ า 
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Microsoft Outlook 

คลกิขวาที ่My Calendar > Add Calendar > From Address Book 

 

เพิม่รายชื่อของเพื่อน 

 

 

 

 

 

 

 

My Calendar > Add Calendar > 
From Address Book 

ปรากฏรายช่ือของเพื่อน 
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ปฏทินิของเพื่อนจะปรากฏขึน้ 

 

Outlook Online 

คลกิ Discover Calendar และเลอืก From Directory แลว้คลกิ Add 
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ปฏทินิทัง้สองจะปรากฏขึน้ 

 

หรอืถ้าผูใ้ชง้านตอ้งการน าเขา้ปฏทินิจากทีอ่ื่น เช่น ตารางการแขง่ขนัฟุตบอล หรอืตารางรายการทวี ีเราสามารถท าได้
เช่นกนั  
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โดยสามารถเพิม่ปฏทินิวนัเกดิ ปฏทินิวนัหยุดของแต่ละประเทศ หรอืน าเขา้ปฏทินิจากระบบอื่นได ้แต่ตอ้งเป็นนามสกุล 
.ICS เท่านัน้ เช่น จาก Hotmail, Google Calendar โดยใหผู้ใ้ชง้านใสล่งิก ์.ICS เขา้ไปยงัช่อง From Web 

 

22. การจดัก าหนดการประชุมไม่ให้ทบัซ้อนกนับน Calendar 

ปัญหาหนึ่งของการนดัหมายการประชุมคอื การจดัหาเวลาว่างทีต่รงกนัของผูเ้ขา้ร่วมประชุมทุกคน อย่างไรกต็าม ดว้ย
ฟีเจอร ์Scheduling Assistant ช่วยใหก้ารตรวจสอบเวลาว่างของผูเ้ขา้ร่วมประชุมทุกคนง่ายดายขึน้ โดยในหน้านัด
หมาย ใหท้ าดงันี้ 

Microsoft Outlook 

คลกิ Scheduling Assistant ตามภาพ 
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โดยระบบจะตรวจสอบเวลาทีเ่หมาะสม โดยดทูี ่Suggested Times และหอ้งทวี่างพรอ้มๆกนั 

 

Outlook Online 

คลกิ Scheduling Assistant ตามภาพ เพื่อดขูอ้มลูเวลาว่างของผูเ้ขา้ร่วมประชุมทุกคน  

ระบบแนะน าเวลาท่ีเหมาะสม 
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23. การแชร ์Calendar 

แมว้่าจะสามารถตรวจสอบเวลาว่างของผูเ้ขา้ร่วมประชุมได ้แต่กเ็ป็นในขณะทีก่ าลงัจะนดัหมายการประชุม แต่หากผู้ใช้
ตอ้งการ กส็ามารถแชรป์ฏทินิใหใ้ครบางคน กลุ่มคน หรอืแชรแ์บบสาธารณะใหทุ้กคนสามารถดปูฏทินิของตนเองได ้ 

โดยสามารถก าหนดรปูแบบการเขา้ถงึได ้ดงันี้ 

- Can View when I’m busy: แสดงปฏทินิของเราเฉพาะ Busy เท่านัน้  

- Can view titles and locations: แสดงปฏิทินของเราเฉพาะหวัข้อ เวลา และสถานที่ แต่ไม่แสดงข้อมูลอื่นๆ 
นอกเหนือจากนี้ 

- Can view all details: แสดงขอ้มลูทัง้หมดทีอ่ยู่ใน Calendar ของเรา 

- Can edit: ใหส้ทิธิใ์นการแกไ้ขปฏทินิเราได ้

Microsoft Outlook 

คลกิ Share Calendar ตามภาพ 
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แลว้เลอืกบุคคลหรอืกลุ่มคนทีต่อ้งการแชรป์ฏทินิใหด้ว้ย  

 

Outlook Online 

คลกิ Share  

 

แลว้เลอืกบุคคลหรอืกลุ่มคนทีต่อ้งการแชรป์ฏทินิใหด้ว้ยตามสทิธิท์ีต่อ้งการ 

เลือกกลุ่มหรอืประเภทท่ีต้องการแชรป์ฏิทิน 
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Contact 

24. เกบ็รายช่ือใน People แบบไม่จ ากดั (Unlimited) 
เมื่อต้องการส่งอเีมลหรอืส่งก าหนดการนัดหมายไปยงับุคคลในบรษิทั ผูใ้ชง้านสามารถใชง้าน Global Address Book 
เพื่อค้นหารายชื่อได้ แต่ถ้าผู้ใช้งานต้องการค้นหารายชื่อบุคคลอื่นภายนอกองคก์ร ผู้ใช้งานสามารถใช้งาน Contact 
View ในการสรา้งรายชื่อขึน้มาใหม่ดว้ยตนเองไดภ้ายใต ้Address Book เดมิ  

Microsoft Outlook 

ใหค้ลกิ  แลว้เลอืกรายชื่อทีต่้องการตดิต่อ จะแสดงขอ้มูลของแต่ละบุคคล สามารถนัดหมาย ส่งอเีมล หรอืพมิพ์
โตต้อบขอ้ความไดท้นัท ีเป็นตน้ วธิเีพิม่รายชื่อใหเ้ลอืก New Contact 

 

Outlook Online 

ให้คลกิ  และเลอืกรายชื่อที่ต้องการติดต่อ จะแสดงขอ้มูลของแต่ละบุคคล โดยผู้ใช้สามารถนัดหมาย ส่งอเีมล 
หรอืพมิพโ์ตต้อบขอ้ความไดท้นัท ีเป็นตน้ วธิเีพิม่รายชื่อใหเ้ลอืก New Contact 
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25. ต้องการสรา้งรายช่ือกลุ่มเอง ให้เลือกใช้ Contact List 

Microsoft Outlook 

คลกิ New Contact > Contact Group 

 

เพิม่สมาชกิของรายชื่อกลุ่ม โดยคลกิ Add members เพิม่สมาชกิทีต่อ้งการ และกรอกชื่อกลุ่ม เพื่อใชใ้นการอา้งองิเวลา
สง่อเีมล  

 

 

 

New Contact > Contact Group 
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เมื่อเวลาเราสง่ถงึกลุ่มรายชื่อน้ีจะปรากฏที ่To 

 

แสดง Contact list ทีถู่กสรา้งแลว้ 

 

Outlook Online 

ผูใ้ชง้านสามารถเพิม่กลุ่มรายชื่อโดยคลกิ New Contact list 
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กรอกขอ้มลูรายละเอยีดของสมาชกิและชื่อกลุ่ม คลกิ Create 

 

เมื่อเวลาเราสง่ถงึกลุ่มรายชื่อน้ีจะปรากฏที ่To 

 

แสดง Contact list ทีถู่กสรา้งแลว้ 
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26. การค้นหารายช่ือผูติ้ดต่อ 

การคน้หารายชื่อบุคคลหรอืกลุ่มนัน้ง่ายมากขึน้ โดยผูใ้ชง้านพมิพแ์ค่ชื่อเท่านัน้ ระบบจะคน้หารายชื่อใหโ้ดยอตัโนมตั ิ 

Microsoft Outlook 

ใหก้รอกชื่อทีต่อ้งการคน้หาลงในช่องคน้หา Search People ทีมุ่มบนขวาของหน้าจอ 

   

Outlook Online 

 ใหก้รอกชื่อทีต่อ้งการคน้หาลงในช่อง Search Mail and People ทีมุ่มบนซา้ยของหน้าจอ 
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27. การเช่ือมต่อกบับริการ LinkedIn 

ถา้ผูใ้ชง้านมบีญัชขีอง LinkedIn (เครอืขา่ยสงัคมออนไลน์ประเภทหนึ่ง) ผูใ้ชง้านสามารถเชื่อมโยงรายชื่อจาก LinkedIn 
มายงั Office 365 ได ้ท าใหท้ราบรายละเอยีดของบุคคลนัน้มากขึน้ ตดิต่อถงึกนัไดส้ะดวกขึน้ โดยใหค้ลกิที ่Manage > 
Connect to Social Network 

Outlook Online 

 

เลอืก Connect 

 

กรอกขอ้มูลของ LinkedIn แล้วคลกิ Connect จากนัน้ รายชื่อจากโปรไฟล์ของ LinkedIn ของผู้ใชง้านจะเชื่อมต่อกบั 
Office 365 ทนัท ี

 

  

Manage > Connect to Social Network 
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Task 

28. การจดัอีเมลและงานให้เป็นระบบด้วย Task 

เครื่องมอืสดุทา้ยคอื Task ซึง่ Task จะช่วยใหผู้ใ้ชง้านตดิตามงานหรอือเีมลใหเ้ป็นไปตามเวลาทีก่ าหนด รวมถงึก าหนด

ความส าคญัก่อนหลงั โดย Task ในทุกๆ รายการอีเมล จะมีรูปธง  อยู่ต่อท้ายทางด้านขวา เครื่องหมายธงนี้มี
ประโยชน์เมื่อผูใ้ชง้านตอ้งการตามงานจากอเีมลนัน้ๆ โดยใหค้ลกิขวา เลอืกตวัเลอืกทีต่อ้งการจากเมนู ซึง่จะเป็นวนัทีท่ี่
ตอ้งการตามงาน  

 

เมื่องานในอีเมลนัน้ๆ เสร็จแล้ว ให้เลือก Mark Complete แล้วจะปรากฏเครื่องหมาย  เพื่อยืนยนัว่างานเสรจ็
สมบรูณ์แลว้ 

29. การสรา้งงาน Task หรอื To-Do list 

Tasks กบั To-Do list จะแตกต่างกนัตรงที ่To-Do list เราใชจ้ดงานว่าเราต้องท าอะไรบา้งเป็นเรื่องส่วนตวั แต่ Tasks 
ราสามารถมอบหมาย Tasks นี้ใหก้บับุคคลอื่นได ้โดยก าหนดในเรื่องของเวลา คลา้ยๆกบัการท า Project Plan 

Task หรอื To-Do list ทีผู่ใ้ชง้านสรา้งทัง้หมดจะถูกเกบ็รวบรวมที ่Tasks 

Microsoft Outlook 

ก าหนด Tasks  จากอเีมล โดยคลกิขวาทีอ่เีมลทีต่อ้งการ เพื่อก าหนดวนัต่างๆ เช่น วนัทีเ่ริม่งาน วนัสง่งาน ฯลฯ ได ้

 

คลิกขวาท่ีอีเมล > Follow Up 
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และเมื่อก าหนดแลว้ ทุก Task จะปรากฏขึน้ โดยคลกิที ่  จะปรากฏดงัภาพ 

 

หากต้องการก าหนดรายละเอียดเพิ่มเติมให้คลิก Task นัน้ขึ้นมา หรือต้องการมอบหมายงานให้บุคคลอื่นให้คลิก 
Assign Task 

 

ก าหนดรายละเอยีดและ % Complete ของงาน 

 

Office Online 

ใน Office Online กเ็ช่นกนั ใหค้ลกิไอคอนดงัภาพ 
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เมื่อต้องการสรา้งงานใหม่ ใหค้ลกิ Add a task กรอกรายละเอยีดของงานทีต่้องท า/ตดิตาม กรอกรายละเอยีดว่าวนัที่
งานเริม่ ก าหนดส่งงาน รวมถงึจะต้องท าซ ้าๆหรอืไม่ เป็นต้น หรอืหากงานนี้เป็นงานทีต่อ้งท าวนันี้ใหเ้ลอืก Add to my 
day เมื่อกรอกเสรจ็แลว้ระบบจะบนัทกึอตัโนมตั ิ

 

งานไหนส าคญั หรอือยู่ในแผนเราสามารถปรบัเปลีย่นประเภทเป็น Important หรอื Planned ไดต้ามล าดบั 
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ถา้งานเสรจ็แลว้ใหค้ลกิเครื่องหมายถูก เพื่อยนืยนัการเสรจ็สิน้ 

 

 

คดิต่อ 

จากเรื่องราวในคู่มอืนี้  ผู้ใช้งานได้เรยีนรู้เกี่ยวกบัการท างานและฟีเจอร์ใน Outlook บน Microsoft Outlook 
และ Outlook Online ผูใ้ชง้านสามารถจดัการอเีมล ปฏทินิ รายชื่อ และงานได ้โดยทัง้ 4 สว่นจะเชื่อมโยงถงึกนั ลองคดิ
ต่อว่า การใชง้าน Outlook แบบเดมิใหใ้ชง้านดมีากขึน้ไดอ้ย่างไร ตวัอย่างเช่น ท าอย่างไรถงึจะลดปรมิาณไฟลแ์นบ,ท า
อย่างไรถงึจะลดปรมิาณอเีมลทีไ่ม่เกีย่วขอ้งกบัตนเอง, ท าการนัดหมายประชุมออนไลน์ หรอืมอบหมายงานใหบุ้คคลที่
เกีย่วขอ้งผ่าน Outlook เป็นตน้ 

หากต้องการศกึษาเพิม่เติมในการใช้งาน Microsoft Outlook สามารถศกึษาได้ที่ “Outlook for Windows Training 
(https://support.office.com/en-us/article/outlook-for-windows-training-8a5b816d-9052-4190-a5eb-
494512343cca)”  

 

 


